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Messaging and Default Accounts Overview

Cisco Unity uses default accounts to provide example configurations for a subscriber and for an 
administrator; to provide an owner for default entities involved in message handling, such as call 
handlers and distribution lists; and to serve as members of default classes of service.

See the following sections:

• About Default Accounts, page 8-1

• About Message Handling, page 8-3

– How Cisco Unity Handles New Messages, page 8-3

– How Cisco Unity Handles Full Mailboxes, page 8-4

– How Cisco Unity Handles Messages Without a Specific Recipient, page 8-6

– How Cisco Unity Handles Private Messages, page 8-7

– How Cisco Unity Handles Messages That Contain Text, page 8-7

About Default Accounts
During the installation of Cisco Unity, the installer is asked to choose the account that will be used to 
administer Cisco Unity. The purpose of this account is to allow administrator access to the Cisco Unity 
Administrator for initial setup. (See the “About the Accounts That Can Be Used to Administer 
Cisco Unity” section on page 2-1 for more information about administrative accounts.)

In addition to the account that is used to access the Cisco Unity Administrator, Cisco Unity creates 
several other default accounts and public distribution lists that you use when setting up the system. The 
Cisco Unity default accounts are detailed below.

Example Administrator

During installation, Cisco Unity creates the Example Administrator account based on the {Default 
Administrator} template. The account is assigned to the Default Administrator class of service, which 
offers the highest level of system access.

The Example Administrator has an Exchange mailbox and an Active Directory account. The account 
alias is EAdministrator, and the default extension is 99999. The default phone password for the Example 
Administrator is 12345. (Note that the default password may be different for your system. If your system 
is a new installation, the installer was prompted to change the default phone password for the {Default 
Administrator} template during installation. However, if your system was upgraded from a version 
earlier than Cisco Unity version 4.0(4), the installer was not prompted to change the default phone 
password during installation.)
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To help protect Cisco Unity from unauthorized access and toll fraud, it is a good idea to specify a 
long—20 or more digits—and non-trivial password for this account. You can change the phone password 
for the Example Administrator account on the Subscribers > Subscribers > Phone Password page in the 
Cisco Unity Administrator at any time.

The Example Administrator account serves as a default owner, message recipient, and member of the 
following Cisco Unity entities:

• Unaddressed Messages distribution list (by default, the Example Administrator is the only member 
of this distribution list)

• All Subscribers distribution list

• Operator call handler

• Opening Greeting call handler

• Goodbye call handler

• Example Interview call handler

• Default Directory handler

• Default Administrator Class of Service (by default the Example Administrator is the only account 
with this class of service)

The Example Administrator subscriber account cannot be deleted from the Cisco Unity Administrator. 
In fact, the account includes the instructions “Do Not Delete” as part of the subscriber name. However, 
the account can be deleted if necessary, by using SQL Server and Active Directory tools. For example, 
you might want to delete the account if the licensed subscriber limit has been reached, or if the account 
is perceived to be a security hazard even with a strong password.

Do not delete the Example Administrator account unless you have finished assigning the appropriate 
subscriber(s) or public distribution list(s) as message recipients or members (as applicable) of the 
Cisco Unity entities with which the account is associated. For more information on the impact of 
deleting the Example Administrator account, see the “Deleting Subscriber Accounts” section on 
page 21-29.

Unity Messaging System

The Unity Messaging System account sends notification when a Cisco Unity report is complete. This 
account also acts as a surrogate sender for messages from unidentified callers. Thus, subscriber 
messages from unidentified callers are identified as coming from the Unity Messaging System mailbox. 
This account also receives nondelivery receipts (NDRs) for voice messages that cannot be delivered—for 
example, when a subscriber mailbox is full—which it then forwards to the public distribution list called 
Unaddressed Messages.

The alias for this account is Unity_<Servername>. The account cannot be seen in the Cisco Unity 
Administrator but can be seen in Active Directory Users and Computers. The mailbox has the display 
name Unity Messaging System.

We recommend that you run the Message Store Manager Utility report on a regular basis to confirm that 
the Unity_<Servername> mailbox is empty (or you can view the mailbox by using Exchange System 
Manager). However, do not set a mailbox size limit for the Unity_<Servername> mailbox. The 
Unity_<Servername> mailbox should not have any messages in it, but setting a mailbox size limit may 
adversely affect messages passing through this mailbox.
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About Message Handling
See the following sections:

• How Cisco Unity Handles New Messages, page 8-3

• How Cisco Unity Handles Full Mailboxes, page 8-4

• How Cisco Unity Handles Messages Without a Specific Recipient, page 8-6

• How Cisco Unity Handles Private Messages, page 8-7

• How Cisco Unity Handles Messages That Contain Text, page 8-7

How Cisco Unity Handles New Messages
When a subscriber listens to a new message, depending on the action that the subscriber takes while 
listening, Cisco Unity will either mark the message as read, or will leave the message marked as a new 
message.

For a new message, the following actions by the subscriber either during or after message playback will 
mark the message as read:

• Save

• Delete

• Skip message, mark as saved

• Hang-up (Note however that the message is marked as read only if the Mark a Message as Saved 
Upon Hang-up or Disconnection setting is enabled for the subscriber; otherwise, the message is 
marked as new)

For a new message, the following actions by the subscriber either during or after message playback will 
leave the message marked as new:

• Reply (and reply to all)

• Forward

• Skip message, save as new

• Skip message, save as is

• Play message properties

• Toggle urgent flag

• Play previous message

• Play next message

• Play first message

• Play last message

• Find a message by number

• Send quick message

• Call the subscriber (live reply)

• Hang-up (Note however that the message is marked as new only if the Mark a Message as Saved 
Upon Hang-up or Disconnection setting is disabled for the subscriber; if the setting is enabled, the 
message is marked as read)
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How Cisco Unity Handles Full Mailboxes
This section explains what Cisco Unity subscribers and callers experience when subscribers have full 
mailboxes.

What Subscribers Experience When Their Mailboxes Exceed Their Limits

Microsoft Exchange dictates the storage limits for subscriber mailboxes. There are three storage limits 
in Exchange, and the Cisco Unity phone conversation and the Cisco Unity Inbox warn subscribers when 
they have reached each limit:

• Issue Warning—When subscriber mailboxes reach the specified value for this storage limit, 
Cisco Unity notifies subscribers when they log on to Cisco Unity by phone by playing the prompt, 
“Your Inbox is almost full. If your Inbox exceeds its storage limit, you will not be able to send or 
receive new messages. To reduce the size of your Inbox, delete some messages now. You will be 
reminded to do so each time you log on until your Inbox is no longer close to its storage limit.” A 
similar message is displayed in the Cisco Unity Inbox.

• Prohibit Send—When subscriber mailboxes reach the specified value for this storage limit, 
subscribers are prohibited from sending messages. Cisco Unity notifies subscribers when they log 
on to Cisco Unity by phone and when they attempt to send a message by playing the prompt, “Your 
Inbox is full. You cannot send new messages. Delete some messages now.” A similar message is 
displayed in the Cisco Unity Inbox.

• Prohibit Send and Receive—When subscriber mailboxes reach the specified value for this storage 
limit, subscribers are prohibited from sending and receiving messages. Cisco Unity notifies 
subscribers when they log on to Cisco Unity by phone and when they attempt to send a message, by 
playing the prompt, “Sorry. Your Inbox is full. You cannot send or receive new messages. Please 
delete some messages now.” A similar message is displayed in the Cisco Unity Inbox.

Additionally, when a subscriber mailbox reaches the Prohibit Send And Receive limit, ViewMail 
will not load when the subscriber starts Outlook. The ViewMail form cannot be published until the 
mailbox size is reduced.

 For ways in which you and subscribers can manage subscriber mailbox size, see the “Best Practices for 
Managing Subscriber Mailbox Size” section in the “Configuring Cisco Unity for Maintenance Tasks” 
chapter of the Maintenance Guide for Cisco Unity.

For more information on Exchange 2000 and Exchange 2003 storage limits, see the “Setting a Maximum 
Size for Exchange Mailboxes” section in the “Configuring Exchange for Maintenance Tasks” chapter in 
the Maintenance Guide for Cisco Unity, or see the Microsoft Exchange documentation.

The Maintenance Guide for Cisco Unity is available at 
http://www.cisco.com/en/US/products/sw/voicesw/ps2237/prod_maintenance_guides_list.html.

What Callers Experience When a Subscriber Mailbox Has Reached the Prohibit Send and Receive Limit

By default, Cisco Unity does not check whether a subscriber mailbox has exceeded the Prohibit Send 
and Receive limit before allowing a caller to leave a message, although Cisco Unity does check before 
sending the message to the subscriber mailbox. If the subscriber mailbox is no longer allowed to receive 
messages, Cisco Unity handles the message as follows:

• If the message was left by an unidentified caller, Cisco Unity sends the message to the Unaddressed 
Messages distribution list, which should be monitored by the Cisco Unity system administrator or 
another subscriber.

Note that if the mailbox(es) of the subscriber(s) who are assigned to check the Unaddressed 
Messages list exceed the Prohibit Send and Receive storage limit that is specified in Exchange, the 
messages that are sent to the Unaddressed Messages distribution list are lost. To avoid this problem, 
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specify a generous value for the Prohibit Send and Receive storage limit for the mailbox of at least 
one subscriber who is a member of the Unaddressed Messages list, and encourage the subscriber to 
dispose of messages promptly so that the Exchange mailbox does not fill up.

• If the message was left by another subscriber, Cisco Unity sends a nondelivery receipt (NDR) 
message to the subscriber who left the message.

Cisco Unity can be set to check whether a subscriber mailbox has exceeded the Prohibit Send and 
Receive limit when an outside caller tries to leave a message for the subscriber. In this circumstance, 
when the mailbox is full, the outside caller hears the following prompt: “You cannot record a message 
for <Subscriber>. This mailbox is full.” After playing the prompt, Cisco Unity transfers the caller back 
to the Opening Greeting and logs the following message to the Windows Application Event log: “The 
mailbox for [Alias: subscriber alias] is full. The subscriber cannot send or receive new voice messages 
until mailbox size is reduced. Mailbox size limits are specified in the message store, not Cisco Unity.”

To enable Cisco Unity to check whether a subscriber mailbox is full when an outside caller tries to leave 
a message for the subscriber, you edit two registry keys:

• A key to allow you to specify that Cisco Unity will check whether a subscriber mailbox is full when 
an outside caller wants to leave a message.

• A key to allow you to enable or disable the prompt that informs callers that they cannot leave a 
message when the mailbox is full.

See the following “To Enable the Full-Mailbox Check and Prompt for Outside Callers” procedure for 
detailed instructions. Note that enabling full-mailbox checks for outside callers does not affect how 
Cisco Unity handles messages from other Cisco Unity subscribers to a full mailbox. Also, Cisco Unity 
behaves as if the full-mailbox check feature is disabled in the following circumstances:

• When an outside caller leaves a message for a call handler whose recipient is a distribution list (for 
example, the default recipient for the Operator call handler is the Unaddressed Messages list).

• When an outside caller leaves a message for an interview handler.

Note For Cisco Unity failover, registry changes on one Cisco Unity server must be made manually on the 
other Cisco Unity server, because registry changes are not replicated.

To Enable the Full-Mailbox Check and Prompt for Outside Callers

Step 1 On the Cisco Unity server desktop, double-click the Cisco Unity Tools Depot icon.

Step 2 In the left pane, under Administrative Tools, double-click Advanced Settings Tool.

Step 3 In the Unity Settings pane, click Conversation—Full Mailbox Check Feature.

Step 4 In the New Value list, click 1, and then click Set.

Step 5 When prompted, click OK.

Step 6 In the Unity Settings pane, click Conversation—Full Mailbox Check Prompt.

Step 7 In the New Value list, click 1, and then click Set.

Step 8 When prompted, click OK.

You do not need to restart Cisco Unity to enable the registry changes.

Step 9 Click Exit.
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How Cisco Unity Handles Messages Without a Specific Recipient
In some situations, messages left in Cisco Unity are not associated with a specific recipient; these 
messages must be screened and routed to the applicable subscriber or call handler. A subscriber should 
be assigned the responsibility of reviewing these messages frequently.

Such messages are left as follows:

Unaddressed Messages Distribution List

Messages that cannot be delivered because the network or a server assigned to a subscriber goes down, 
or because the subscriber mailbox has exceeded the Prohibit Send and Receive limit specified for the 
mailbox in Exchange, are forwarded to the Unaddressed Messages distribution list. By default, this 
distribution list contains the Example Administrator as its only member.

To route these messages properly, ensure that the Unaddressed Messages distribution list has at least one 
member (such as the operator) who will monitor the mailbox and handle messages that cannot be 
delivered. (See the “To Add Subscribers to the Unaddressed Messages Distribution List” procedure on 
page 8-6 for instructions.)

Note that if the mailbox(es) of the subscriber(s) who are assigned to check the Unaddressed Messages 
list exceed the Prohibit Send and Receive storage limit that is specified in Exchange, the messages sent 
to the Unaddressed Messages distribution list are lost. To avoid this problem, specify a generous value 
for the Prohibit Send and Receive storage limit for the mailbox of at least one subscriber who is a 
member of the Unaddressed Messages list, and encourage the subscriber to dispose of messages 
promptly so that the Exchange mailbox does not fill up.

Operator, Opening Greeting, and Goodbye Call Handlers

When a caller to Cisco Unity dials the operator and no operator is available, the caller can leave a 
message, depending on the call transfer settings for the Operator call handler. Call transfer settings in 
the Opening Greeting and Goodbye call handlers also can allow callers to leave a message. By default, 
messages left in any of these call handlers are sent to the Unaddressed Messages distribution list.

Example Interview

When callers are routed to the Example Interview, which gathers basic information about who they are 
and who they are trying to reach, the answers to the questions are routed by default to the Example 
Administrator. If you want these messages to be routed to another recipient, choose a subscriber (such 
as the operator) or a distribution list as the recipient.

To Add Subscribers to the Unaddressed Messages Distribution List

Step 1 In the Cisco Unity Administrator, go to any Subscribers > Public Distribution Lists page.

Step 2 Click the Find icon.

Step 3 Double-click the Unaddressed Messages distribution list.

Step 4 Change settings as applicable, and then click the Save icon.
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How Cisco Unity Handles Private Messages
Messages marked private cannot be forwarded by phone, from Cisco Unity ViewMail for Microsoft 
Outlook, or from the Cisco Unity Inbox. This includes any voice message that a Cisco Unity subscriber 
marked private, and as applicable, any e-mail message that a subscriber or another sender marked private 
in Outlook. In addition, when a message is marked private, the Copy and Copy To options are disabled 
on the Options menu on the Media Master control bar in ViewMail for Outlook and the Cisco Unity 
Inbox.

For subscribers who require more secure messaging, consider the following:

• You can set up secure messaging and enable subscribers to use it. Secure messaging provides 
security through the use of public/private key encryption for voice messages. Secure messages 
cannot be heard by anyone other than a Cisco Unity subscriber who is authenticated with their 
Cisco Unity server. For information on how to set up secure messaging, see the “Secure Messaging” 
section in the “Securing Subscriber Messages” chapter of the Security Guide for Cisco Unity. The 
guide is available at 
http://www.cisco.com/en/US/products/sw/voicesw/ps2237/prod_maintenance_guides_list.html.

• You can prevent subscribers from saving any voice message—regardless of its sensitivity—to their 
hard disks by disabling the Copy to File option on the Options menu of the Media Master control 
bar in the Cisco Unity Inbox. To learn more, see Advanced Settings tool Help (in the Unity Settings 
list, click Unity Inbox—Disable Copy to File Option in Media Master). The Advanced Settings tool 
is available in Tools Depot.

How Cisco Unity Handles Messages That Contain Text
If your organization has both Voice Messaging and Unified Messaging subscribers, messaging between 
the two types of subscribers can be problematic. This is because Voice Messaging subscribers cannot use 
the Cisco Unity conversation or the Cisco Unity Inbox to access text in e-mail messages. In addition, 
when a message contains both a voice recording and a text message—as may be the case when a Unified 
Messaging subscriber uses Cisco Unity ViewMail for Microsoft Outlook to send, reply to, and forward 
messages to Voice Messaging subscribers, the Cisco Unity conversation and the Cisco Unity Inbox 
present only the voice portion of the message. Moreover, Cisco Unity informs neither the sender nor the 
recipient that all or a portion of a message is unavailable to the recipient.

You can set up Cisco Unity so that it rejects messages sent to Voice Messaging subscribers if the 
messages contain text. In this way, you can ensure that Voice Messaging subscribers receive only those 
messages that they can play in their entirety. At the same time, when Cisco Unity rejects messages that 
contain text, Unified Messaging subscribers receive a nondelivery receipt (NDR) and can learn to adjust 
their messaging habits accordingly.

For more information, see the following sections:

• Using the Message Store Manager to Change How Cisco Unity Handles Messages That Contain 
Text, page 8-8

• Understanding How Messages That Contain Text Are Handled After You Set Up Cisco Unity to 
Reject Them, page 8-8

• Task List for Setting Up Cisco Unity to Reject Messages That Are Sent to Voice Messaging 
Subscribers When the Messages Contain Text, page 8-11
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Using the Message Store Manager to Change How Cisco Unity Handles Messages That Contain Text

The Message Store Manager utility allows you to set up agents that perform the task that you assign them 
to do. You specify which subscriber mailboxes are members of an agent; only the mailboxes that you 
specify are affected by the task performed by the agent.

To set up Cisco Unity so that it rejects messages that are sent to Voice Messaging subscribers, if the 
messages contain text, you need to create two agents:

• The first agent applies a rule that rejects messages that contain text. The agent applies the rule to the 
subscriber mailboxes that you specify as agent members. You can use a Cisco Unity distribution list, 
class of service, extension range, or an imported CSV file to specify agent members. However, we 
recommend that you use a distribution list or class of service, because as you add members to the 
distribution list or class of service, membership in the agent will be automatically updated at the 
same time.

• The second agent removes the rule that was applied by the first agent from subscriber accounts that 
no longer need it. Once the first agent is set up, it will continue to reject messages that contain text 
until the second agent removes it. If you do not set up the second agent, even after you remove a 
subscriber from the distribution list or class of service that you specified as a member of the first 
agent, the first rule will continue to reject messages from that subscriber mailbox if the messages 
contain text. We recommend that you set up both agents at the same time, setting the second agent 
to remove the rule from all subscriber mailboxes on the server except those that are associated with 
Voice Messaging subscribers. When the agents are set up this way, you will not have to create a new 
agent to remove the rule from a single mailbox each time that a Voice Messaging subscriber is 
removed from the distribution list or class of service that you specified for the first agent.

You schedule when and how often you want each agent to run. For example, you may choose to run the 
agents nightly or weekly, depending on how often you add or remove subscribers from the class of 
service or distribution list that you use to specify agent membership. As you determine a schedule for 
running the agents, consider that when Voice Messaging subscribers are set to not appear in the Outlook 
address books, the agents will take longer to run. Also note that while an agent is running, any previously 
hidden mailboxes appear in address books, and then, when the agent has completed its task, the 
mailboxes are hidden once again. For this reason, you may want to schedule the agents to run when 
subscribers are not likely to use the system. (Voice Messaging subscribers are often prevented from 
appearing in the Outlook address book as way of discouraging people from inadvertently sending e-mail 
messages to a Voice Messaging account.)

When you set up the agents, you can activate the Subscriber Message Store Status report (or you can 
schedule the report to run at a later time) to gather detailed data about each subscriber mailbox that is a 
member of the agent. When the value of the VM Mailbox Rule column equals one (1), the rule associated 
with the first agent has been applied; when the value equals zero (0), the rule has not been applied to the 
mailbox.

For more information on working with Message Store Manager to set up agents and run reports, see 
Message Store Manager Help.

Understanding How Messages That Contain Text Are Handled After You Set Up Cisco Unity to Reject 
Them

When you set up Cisco Unity so that it rejects messages sent to Voice Messaging subscribers when the 
messages contain text, Voice Messaging subscribers continue to receive receipts, faxes, and voice 
messages as before, but many other types of messages are no longer delivered. Knowing how 
Cisco Unity handles messages differently can help you prepare both Voice Messaging and Unified 
Messaging subscribers for the change.
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Table 8-1 compares how Cisco Unity handles messages by default, to how Cisco Unity handles 
messages after you have set it to reject messages that are sent to Voice Messaging subscribers when the 
messages contain text. Keep in mind that when Cisco Unity rejects a message, it does so when the Voice 
Messaging subscriber is the sole recipient of the message, and also when the subscriber is one of many 
recipients, as may be the case when a message containing text is sent to a distribution list. Note that in 
a few cases, Cisco Unity does not reject certain types of messages that you may expect, while it rejects 
others that you may not expect.

Table 8-1 How Messages That Contain Text Are Handled When Sent to Voice Messaging Subscriber

Type of Message
Application Used to 
Send Message

How Cisco Unity Handles Message by 
Default

How Cisco Unity Handles 
Messages When Set Up to Reject 
Messages That Contain Text

Voice message with text in 
subject line

ViewMail Delivers message as voice message; 
Voice Messaging subscribers can 
access subject line only in 
Cisco Unity Inbox.

Does not deliver message; sends 
an NDR to sender.

Voice message with text in 
subject line

Cisco Unity Inbox Delivers message as voice message; 
Voice Messaging subscribers can 
access subject line only in 
Cisco Unity Inbox.

Same as default.

Voice message with text in 
message body

ViewMail Delivers message as voice message; 
Voice Messaging subscribers cannot 
access text.

Does not deliver message; sends 
an NDR to sender.

Voice message with a 
non-WAV attachment

ViewMail Delivers message as voice message; 
Voice Messaging subscribers cannot 
access the attachment.

Does not deliver message; sends 
an NDR to sender.

Reply to voice message 
with voice recording and 
text in message body

ViewMail Delivers message as voice message; 
Voice Messaging subscribers cannot 
access text.

Does not deliver message; sends 
an NDR to sender.

Reply to voice message 
with text in message body

ViewMail Delivers message as e-mail message 
that Voice Messaging subscribers 
cannot access.

Does not deliver message; sends 
an NDR to sender.

Reply to voice message 
with non-WAV attachment

ViewMail Delivers message as voice message; 
Voice Messaging subscribers cannot 
access the attachment.

Does not deliver message; sends 
an NDR to sender.

Reply to voice message 
with no voice recording, 
no change to subject line, 
and no text in message 
body

ViewMail Delivers message as e-mail message 
that Voice Messaging subscribers 
cannot access.

Does not deliver message; sends 
an NDR to sender.

Reply to voice message 
with change to text in 
message body

ViewMail Delivers message as voice message; 
Voice Messaging subscribers cannot 
access text.

Does not deliver message; sends 
an NDR to sender.

Reply to voice message 
with change to subject line

ViewMail Delivers message as voice message; 
Voice Messaging subscribers can 
access subject line only in 
Cisco Unity Inbox.

Does not deliver message; sends 
an NDR to sender.
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Reply to voice message 
with change to subject line

Cisco Unity Inbox Delivers message as voice message; 
Voice Messaging subscribers can 
access subject line only in 
Cisco Unity Inbox.

Same as default.

Reply to voice and text 
message with voice 
recording and deletion of 
all text

ViewMail Delivers message as voice message; 
Voice Messaging subscribers cannot 
access text.

Same as default.

Reply to voice and text 
message with voice 
recording

Cisco Unity 
conversation

Delivers message as voice message; 
Voice Messaging subscribers cannot 
access text.

Does not deliver message; sends 
an NDR to sender.

Reply to voice and text 
message with voice 
recording

Cisco Unity Inbox or 
ViewMail

Delivers message as voice message; 
Voice Messaging subscribers cannot 
access text.

Same as default.

Reply to e-mail message 
with voice recording and 
text in message body

ViewMail Delivers message as voice message; 
Voice Messaging subscribers cannot 
access text.

Does not deliver message; sends 
an NDR to sender.

Reply to e-mail message 
with voice recording

Cisco Unity 
conversation or 
ViewMail

Delivers message as voice message; 
Voice Messaging subscribers cannot 
access text.

Same as default.

Reply to e-mail message 
with text in message body

ViewMail Delivers message as e-mail message 
that Voice Messaging subscribers 
cannot access.

Does not deliver message; sends 
an NDR to sender.

Forwarded voice message 
with voice introduction 
and text in message body

ViewMail Delivers message as voice message; 
Voice Messaging subscribers cannot 
access text.

Does not deliver message; sends 
an NDR to sender.

Forwarded voice message 
with text in message body

ViewMail Delivers message as voice message; 
Voice Messaging subscribers cannot 
access text.

Does not deliver message; sends 
an NDR to sender.

Forwarded voice message 
with non-WAV attachment

ViewMail Delivers message as voice message; 
Voice Messaging subscribers cannot 
access the attachment.

Does not deliver message; sends 
an NDR to sender.

Forwarded voice message 
with change to text in 
message body

ViewMail Delivers message as voice message; 
Voice Messaging subscribers cannot 
access text.

Does not deliver message; sends 
an NDR to sender.

Forwarded voice message 
with change to subject line

ViewMail Delivers message as voice message; 
Voice Messaging subscribers can 
access subject line only in 
Cisco Unity Inbox.

Does not deliver message; sends 
an NDR to sender.

Forwarded voice message 
with change to subject line

Cisco Unity Inbox Delivers message as voice message; 
Voice Messaging subscribers can 
access subject line only in 
Cisco Unity Inbox.

Same as default.

Table 8-1 How Messages That Contain Text Are Handled When Sent to Voice Messaging Subscriber (continued)

Type of Message
Application Used to 
Send Message

How Cisco Unity Handles Message by 
Default

How Cisco Unity Handles 
Messages When Set Up to Reject 
Messages That Contain Text
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Task List for Setting Up Cisco Unity to Reject Messages That Are Sent to Voice Messaging 
Subscribers When the Messages Contain Text

Complete the following tasks to set up Cisco Unity so that it rejects messages that are sent to Voice 
Messaging subscribers when the messages contain text:

1. Identify the Voice Messaging subscribers on your Cisco Unity server. For example, create a class of 
service or public distribution list for Voice Messaging subscribers, and then use the Cisco Unity 
Administrator or Bulk Edit to assign the appropriate subscribers to it. (Note that how you 
differentiate Voice Messaging subscribers from Unified Messaging subscribers is up to you; nothing 
in the way that you created them, nor in how they are licensed, identifies them as Voice Messaging 
or Unified Messaging subscribers for this feature.)

Forwarded voice and text 
message with or without 
voice introduction

ViewMail Delivers message as voice message; 
Voice Messaging subscribers cannot 
access text.

Same as default.

Forwarded voice and text 
message with or without 
voice introduction

Cisco Unity 
conversation or the 
Cisco Unity Inbox

Delivers message as voice message; 
Voice Messaging subscribers cannot 
access text.

Does not deliver message; sends 
an NDR to sender.

Forwarded voice and text 
message with deletion of 
all text

ViewMail Delivers message as voice message. Same as default.

Forwarded e-mail with 
text in message body

ViewMail Delivers message as e-mail message 
that Voice Messaging subscribers 
cannot access.

Does not deliver message; sends 
an NDR to sender.

Forwarded e-mail 
message with voice 
introduction and text in 
message body

ViewMail Delivers message as voice message; 
Voice Messaging subscribers cannot 
access text.

Does not deliver message; sends 
an NDR to sender.

Forwarded e-mail 
message with voice 
introduction

Cisco Unity 
conversation or 
ViewMail

Delivers message as voice message; 
Voice Messaging subscribers cannot 
access text.

Same as default.

Forwarded e-mail 
message with no change to 
subject line or additional 
text

Cisco Unity 
conversation or 
ViewMail

Delivers message as e-mail message 
that Voice Messaging subscribers 
cannot access.

Does not deliver message; sends 
an NDR to sender.

E-mail message with 
WAV attachment

E-mail program Delivers message as e-mail message 
that Voice Messaging subscribers 
cannot access; Voice Messaging 
subscribers cannot access the 
attachment.

Does not deliver message; sends 
an NDR to sender.

E-mail message E-mail program Delivers message as e-mail message 
that Voice Messaging subscribers 
cannot access.

Does not deliver message; sends 
an NDR to sender.

Table 8-1 How Messages That Contain Text Are Handled When Sent to Voice Messaging Subscriber (continued)

Type of Message
Application Used to 
Send Message

How Cisco Unity Handles Message by 
Default

How Cisco Unity Handles 
Messages When Set Up to Reject 
Messages That Contain Text
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2. Set up the two agents that will enable Cisco Unity to reject messages that are sent to Voice 
Messaging subscribers when the messages contain text. See the “To Set Up an Agent to Reject 
Messages That Contain Text When the Messages Are Sent to Voice Messaging Subscribers” 
procedure on page 8-13 and the “To Set Up an Agent to Ensure Unified Messaging Subscribers 
Receive Messages That Contain Text” procedure on page 8-13.

3. Customize ViewMail for Outlook so that when it is installed on subscriber workstations, messages 
that are sent to Voice Messaging subscribers are checked for text. You need to do this even if you 
are upgrading subscriber workstations from a customized version of ViewMail 4.1(1) to 
ViewMail 4.2(1). See the “To Customize ViewMail for Outlook Version 4.1(1) and Later to Check 
for Text When Subscribers Send Messages to Voice Messaging Subscribers” procedure on 
page 8-14.

4. Install the customized version of ViewMail on all subscriber workstations. See the “To Install the 
Customized Version of ViewMail on All Subscriber Workstations” procedure on page 8-14.

Note If you already installed a standard version of ViewMail on subscriber workstations, you cannot simply 
install the customized version of ViewMail to enable the feature. You also cannot repair the existing 
installation to enable the feature. To enable the feature if you already installed a standard version of 
ViewMail, you must change the value of a registry key to 1 on each subscriber workstation. The registry 
key is HKEY_LOCAL_MACHINE\SOFTWARE\Cisco Systems\Cisco Unity\VMO\NoTextToVM. It is 
a DWORD key. You can edit the registry on each subscriber workstation, or you can use a software 
publishing tool to update the key value on all subscriber workstations at once.

5. Subscribers who use Microsoft Outlook 2002 and later will get a Microsoft Outlook security alert 
when they use the customized version of ViewMail. Tell subscribers that they can safely click Yes 
in response. The standard text for the security alert informs users that an application is attempting 
to access the Outlook Address Book, and asks them if they want to allow it. (In fact, ViewMail does 
not access the Address Book, but it does check for text in each message that triggers the alert.) To 
learn more about the Microsoft Outlook Security feature—as well as how to customize or disable it, 
see the Microsoft Office Assistance topic “Customizing the Outlook Security Features 
Administrative Package,” in the “Administering Outlook Security” chapter of the Messaging 
Deployment Guide on the Microsoft website.

6. Consider letting subscribers know what to expect now that Cisco Unity rejects messages sent to 
Voice Messaging subscribers when the messages contain text. Give everyone a list of Voice 
Messaging subscribers so that they know which subscribers cannot receive messages that contain 
text. In addition, tell Unified Messaging subscribers that if they receive an NDR in response to a 
message that they sent to a Voice Messaging subscriber, they should remove all text before 
attempting to resend the message. Remind them that NDRs can also be triggered when a recipient 
has a full mailbox.

Note When you move a Voice Messaging subscriber mailbox from one Exchange server to another, the rules 
associated with the mailbox continue to work after the move. The same is true when you move a Voice 
Messaging subscriber from one Cisco Unity server to another. If the other Cisco Unity server is not 
already set up to reject messages that contain text, consider enabling it so that messages to Voice 
Messaging subscribers are handled consistently. Alternatively, you can create a new agent to remove the 
rule from the individual mailbox before moving the subscriber to the other Cisco Unity server.
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To Set Up an Agent to Reject Messages That Contain Text When the Messages Are Sent to Voice Messaging 
Subscribers

Step 1 On the Cisco Unity server desktop, double-click the Cisco Unity Tools Depot icon.

Step 2 In the left pane, under Administrative Tools, double-click Message Store Manager.

Step 3 From the File menu, click New Agent.

Step 4 Enter a name for the agent, then click OK. For example, consider naming the agent, “Reject Text to VM 
Subscribers.”

Step 5 Right-click the Included folder, and click the option that allows you to specify that only Voice 
Messaging subscribers are members of the agent. For example, if you created a class of service to 
identify Voice Messaging subscribers on your server, you would click Add Class of Service.

Step 6 Click the applicable class of service or distribution list, then click OK.

Step 7 Click the Scripts directory.

Step 8 From the list displayed in the right pane, right-click Add VM Mailbox Rules and click Activate.

Step 9 In the MSM Script dialog box, click the Schedule tab. Specify how often you want the agent to run.

Note The agent takes longer to run if any members are currently hidden from Outlook address books.

Step 10 Click OK to close the MSM Script dialog box.

To Set Up an Agent to Ensure Unified Messaging Subscribers Receive Messages That Contain Text

Step 1 From the File menu, click New Agent.

Step 2 Enter a name for the agent, then click OK. For example, consider naming the agent, “Remove VM 
Subscribers Rule.”

Step 3 Right-click the Included folder, and click the option that allows you to specify all subscribers as 
members of the agent. For example, if you have an All Subscribers distribution list, you would click Add 
Distribution List.

Step 4 Click the applicable class of service or distribution list, then click OK.

Step 5 Right-click the Excluded folder, and click the option that allows you to specify that Voice Messaging 
subscribers are excluded as members of the agent. For example, if you created a class of service to 
identify Voice Messaging subscribers, you would click Add Class of Service.

Step 6 Click the applicable class of service or distribution list, then click OK.

Step 7 Click the Scripts directory.

Step 8 From the list displayed in the right pane, right-click Delete VM Mailbox Rules and click Activate.

Step 9 In the MSM Script dialog box, click the Schedule tab and specify how often you want the agent to run.

Note The agent takes longer to run if any members are currently hidden from Outlook address books.

Step 10 Click OK to close the MSM Script dialog box.
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To Customize ViewMail for Outlook Version 4.1(1) and Later to Check for Text When Subscribers Send Messages 
to Voice Messaging Subscribers

Step 1 Download ViewMail or browse to the ViewMail directory on the Cisco Unity DVD, as applicable. See 
the applicable Release Notes for Cisco Unity ViewMail for Microsoft Outlook for the version of 
ViewMail that you are customizing. The document is available at 
http://www.cisco.com/en/US/products/sw/voicesw/ps2237/prod_release_notes_list.html.

Step 2 In the ViewMail directory, browse to the ENU language folder.

Step 3 Open the VMOInit.VBS file in a text editor such as Notepad.

Step 4 Enter Session.Property("NOTEXTTOVM") = "1" immediately before the End Function line, as 
shown below:

Function VMOInitFn()
rem Session.Property("EXTENSION") = ""
rem Session.Property("UNITYSERVER") = ""
Session.Property("NOTEXTTOVM") = "1"
End Function

Step 5 Save the script file and close the text editor.

Step 6 Open a Command Prompt window. (On the Windows Start menu, click Programs > Accessories > 
Command Prompt.)

Step 7 Change to the ViewMail > ENU directory.

Step 8 Enter vmaddbin ViewMail.MSI VMOInit.VBS, and press Enter. (When the script completes, your 
cursor returns to the command line.)

Step 9 Close the Command Prompt window.

To Install the Customized Version of ViewMail on All Subscriber Workstations

Step 1 For the version of ViewMail that you customized in the “To Customize ViewMail for Outlook Version 
4.1(1) and Later to Check for Text When Subscribers Send Messages to Voice Messaging Subscribers” 
procedure on page 8-14, review the applicable Release Notes for Cisco Unity ViewMail for Microsoft 
Outlook at http://www.cisco.com/en/US/products/sw/voicesw/ps2237/prod_release_notes_list.html for 
requirements, installation instructions, and other important information.

Step 2 By using the ViewMail.msi file that you customized, install ViewMail on all subscriber workstations.

You can install ViewMail by using any of the methods described in the applicable Release Notes for 
Cisco Unity ViewMail for Microsoft Outlook.
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